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TIPS AutoCAD Map 3D 2009 Installation Instructions 
 

Getting Started  
 

 Before starting the installation process, you will need the following: 
 

 AutoCAD Map 3D 2009 disk.  Note that the 2009 version is distributed on a 
single DVD.   

 Serial number and environment variable information provided with the 
distribution. 

 A network shared folder (if creating a network deployment image).  This is the 
location where the deployment (i.e., Microsoft Installer Administrative Image) 
will be created.  It must be a network share with full access privileges.  The 
deployment image will take approximately 2.35 GB of disk space. 

 Approximately 45 minutes to create the deployment image; thereafter, 20 – 30 
minutes to install the program on each user machine (including verification of the 
installation).  

 

General Overview  
 

1. Deployment Image (Recommended) - Although AutoCAD Map 3D 2009 can be installed 
directly on each client (i.e., user) machine, we recommend that a network deployment 
image be created and used for consistent installation.  The deployment image allows you 
to control what gets installed on the individual workstations, without having to configure 
each installation separately.  Once created, the image can be used for installation on user 
machines for the life of the software.  The deployment installs all files necessary to run 
the program on each user computer, and no communication with the image is required 
after the initial installation. 

2. Direct Install (Optional) - As an option, the software can be installed directly to user 
machines without creation of a deployment image.  This will require separate (i.e., 
repeated) configuration for each client installation.  The installation procedure is the same 
as that shown below under ‘Create a Network Deployment Image,’ minus references to 
deployment image name, directory location, and general deployment settings.   

3. All installations must be configured as “Network, Single License Server” license type. 
4. The environment variable ADSKFLEX_LICENSE_FILE must be set on each user 

machine according to the documentation provided in the software distribution package.  
Note that if a previous version of TIPS AutoCAD software was installed, the variable 
will already be set. 

5. Each user should open AutoCAD Map 3D 2009 at least once before installing any 
updates or associated software (e.g., AutoCAD Raster Design, Carlson Mining, etc.). 

6. Updates available at the time of this distribution can be found on the DVD in the Patches 
& HotFixes folder.  Note that the Render Hotfix is applied as part of Service Pack 1; the 
Open Close Save Hotfix should be applied after installation of Service Pack 1.  Visit 
http://www.autodesk.com/support to check for current updates and service packs. 

7. If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at 
(276) 523-0042 x13 or TBUCKMASTER@OSMRE.GOV.  

http://www.autodesk.com/support
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Insert the AutoCAD Map 3D 2009 Installation DVD 
• Insert the disk labeled AutoCAD Map 3D 2009 (If the setup does not start automatically,  

browse to <DVD DRIVE>:\setup.exe to initialize). 
 

 
 
• Recommended Installation:  Click Create Deployments.  This will initiate creation of a 

deployment image on a network drive.  The deployment image can then be used to install 
the software on any number of client (i.e., user) machines over the life of the software 
version.  Continue with Create a Network Deployment Image, below. 

 

 
 

• Optional Installation:  Click Install Products.  This will initiate direct installation of the 
software on the current user machine; installation configuration will have to be repeated 
for each user. 
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Create a Network Deployment Image 

 
• Specify (or “Browse” to select) a Network Directory location where the deployment 

image is to be created and later accessed for installation on user computers. 
• Specify a name for the deployment (e.g., Map 3D 2009 Network Deployment).  This 

names the associated program shortcut for the deployment. 
• Click Next.   
• Note: This window is not applicable if using the direct install option. 
 

  
 
• Check the box next to ‘AutoCAD Map 3D 2009’ to include it in the deployment.  The 

program requires between 2.0 and 2.2 GB of disk space on user computers, depending on 
configuration options. 

• Optional (Recommended):  Check the box next to ‘Autodesk Design Review 2009’ to 
include it in the deployment; this requires an additional 113 MB of disk space. 

• Click Next to continue. 
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• Review license agreement and select (i.e., click in the circle next to) “I Accept” if 

acceptable. 
• Click Next to continue. 

 

 
 

• Enter the serial number provided with the software distribution. 
• Enter ‘TIPS’ as the First name; ‘OSM’ as the Last name; and, ‘USDOI’ as the 

Organization to identify the installation as a TIPS product.  
• Click Next to continue. 
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• Select the desired options for Log file, Silent mode installation, and Customer 

Involvement Program.  The default options (as shown) are acceptable. 
• Click Next to continue.  
• Note: This window is not applicable if using the direct install option.  Proceed to next 

step. 
 

 
 

• Verify / select ‘AutoCAD Map 3D 2009’ as the product to be configured. 
• Click Configure to proceed. 
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• Click the circle next to ‘Network license’. 
• Select the license server model ‘Single License Server’. 
• Enter ‘TIPS’ as the name of the license server. 
• Click Next to continue. 

 

 
 

• You will get a warning that the server does not exist. 
• Click Yes to ignore the warning and continue. 
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• Verify / select ‘Typical’ as the installation type and ‘Express Tools’ as an option. 
• We also recommend installing the ‘Materials Library.’  This feature requires 

approximately 170 MB of the 2.2 GB of disk space indicated in the screen capture below. 
• (If using the direct install option, there will also be a choice to create a desktop shortcut.) 
• Verify the install path.  The default ‘C:\Program Files\AutoCAD Map 3D 2009\’ is 

recommended. 
• Click Next to continue. (If using the direct install option, continue to the bottom section 

of page 12.) 
 

 
 

• This window allows for customization of various search paths and file locations.  The 
defaults are suitable for most users. 

• Click Next to continue. 
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• This window allows for including additional files / folders as part of the deployment. 
• Click Next to continue. 

 

 
 

• Un-check / deselect the box next to ‘Internet Explorer is required for installations.’ 
• The remaining default selections are acceptable and recommended. 
• Click Next to continue. 
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• This window allows the inclusion of Service Packs as part of the deployment.  Service 
Pack 1 is included as part of the TIPS distribution (under the ‘Patches & Hotfixes’ 
directory on the DVD) 

• Inclusion of the Service Pack in the Deployment is optional; if the deployment is created 
without the Service Pack, it can be installed after initial installation on user computers as 
shown below on pages 21 – 22. 

• To include the service pack with the deployment image, click Browse. 
• To skip inclusion of the service pack, click Next and proceed to page 11 (bottom). 
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• Navigate to the .msp file on the DVD (e.g., ACADMAP12(D:)\Patches & Hotfixes\Map 

3D 2009 Service Pack 1\). 
• Select the file ‘autocadmap3d2009lockedsp1.msp’ and click Open.  
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• Verify that that ‘AutoCAD Map 3D 2009 Version 2’ is listed as included. 
• Verify that ‘Append service packs onto the deployment’ is selected. 
• Click Next to continue. 
 

 
 

• It is recommended that ‘Enable live updates’ and ‘Enable Information Channels’ are 
selected; this ensures that users are made aware of program updates and issues. 

• ‘Enable CAD Manager Channel’ and ‘Enable RSS feeds’ are not necessary / 
recommended for the typical TIPS user. 

• Click Next to continue. 
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• Configuration defaults (as shown) are recommended for Access to Online Resources. 

 
• Click Next to continue. 

 
 

T• 
• Click on the ‘Autodesk Design Review 2009’ tab to verify configuration for th

program.  Note that if you chose not to in

his completes the configuration for AutoCAD Map 3D 2009. 
at optional 

stall Design Review (page 3, above), the tab 
that case, proceed to page14.).  

 
will not be available (in 
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• Verify / select ‘AutoCAD Design Review 2009’ as the product to be configured. 
• Click Configure to proceed. 
 

 
 

• Verify the install path.  The default ‘C:\Program Files\Autodesk\Autodesk Design 
Review\’ is recommended. 

• (If using the direct install option, there will also be a choice to create a desktop shortcut.) 
• Click Next to continue. 
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 This completes the configuration for Autodesk Design Review 2009 and / or AutoCAD 
Map 3D 2009. 

• Click Configuration Complete to continue. 
 

•

 
  

• Review the settings to ensure that the configuration is as intended.  If desired, you can 
also print the settings for your records. 

• If settings are correct, click Create Deployment to continue. 
• If using the direct install option, click Install; the installation should complete in 

approximately 20 minutes.  At that point click Finish and continue on to ‘Verify 
Installation / Network Licensing’ on page 17. 
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• The deployment will now be created.  The process will rotate through several screen 

0 minutes. 
images as necessary files are copied to the deployment.  The process will typically take 
approximately 3

 

 
 

• When the process has completed, note the links for product installation and deploy
modification shown on the summary window. 

• Click Finish to complete the process and exit. 

ment 
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Install AutoCAD Map 3D 2009 on Client Machines 
 

• From the client machine, navigate to the directory that contains the Network Deployment 
Image (i.e., the network directory that was specified during creation of the deployment 
image; see page 3 and the step on bottom of page 15.). 

• Double click on the shortcut in this directory.  It will have what ever name you specified 
during creation of the deployment image (see page 3 and / or the bottom section of page 
15). 

• Optionally, the shortcut can be copied to an alternate, more convenient location and 
accessed there; note that the network directory where the deployment was created is 
referenced by the shortcut and must be accessible for installation to proceed.  

 

 
 

•  Installation will begin and should take 15 - 20 minutes to complete, depending on 
network connection and client machine speed. 

 

 
 



 
9/15/2008 AutoCAD Map 3D 2009 Page 17 of 23 

• Note that the status window will simply close (i.e., disappear) when installation is 
complete.  There will not be a “notice” that the installation was successful.  
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Verify Installation / Network Licensing 

 
• Have the user login and launch AutoCAD Map 3D 2009 from the Start Menu or from the 

desktop shortcut. 

 
 

or 
 

 
 

• The Migrate Custom Settings window allows the user to import custom settings from 
previous versions of the software.  However, there have been problems reported with 
such migrations that result in toolbar menu problems for the previous version.  As 
such, it is STRONGLY RECOMMENDED THAT MIGRATION NOT BE USED. 

• Click on Cancel to continue without migrating settings.. 
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lt workspace. 

 Check the box next to ‘Don’t Show me this again.’ 
• Scroll to and select ‘Map Classic’ as the defau
•
• Click OK to continue. 
 

 
 

• Select the circle next to ‘Maybe later’ to enable the user to be reminded of the New 
Features Workshop on the next program launch (The New Features Workshop can also 
be accessed at any time from the program ‘Help’ menu.). 

• Click OK to continue. 
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• The program will open… 
 

 
 

• To verify that the client installation has performed properly, go to the ‘Help’ menu 
ut AutoCAD Map 3D. pulldown and click Abo
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• Click on the Product Information button. 

 

 
 

• Verify that the value for ‘License type’ is ‘Network’.  If the value is anything else, the 
installation did not perform properly and the licensing is not valid. 

• Note: If service pack 1 was included with the deployment, the ‘Product service pack’ 
value will be ‘AutoCAD Map 3D 2009 Version 2’ rather than ‘0’ as shown. 

• After verifying the settings, click Close. 
 

 
 

• Go to the ‘File’ menu pulldown and click Exit to close the program. 
• Proceed to the installation of Service Pack 1, below (if not previously applied as part of 

the deployment image). 
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chines 

 
This procedure is necessary only if using the direct install option or the service pack was not 
included with the deployment image as discussed on page 9. 
  
Service Pack 1 (i.e., SP1) was the latest available at the time of the TIPS software 
distribution and can be found on the distribution DVD in the Patches & HotFixes folder.  
 
Visit http://www.autodesk.com/support

Install Service Pack 1 on Client Ma

 to check for more current issues.  Newer versions, if 
available, would be downloaded and installed as directed by Autodesk. 
 
• To initiate installation of SP1, browse/navigate to <DVD DRIVE>:\Patches & Hotfixes\ 

Map 3D 2009 Service Pack 1. 
• Double click on the file autocadmap3d2009lockedsp1.exe to initialize installation of the 

update. 
 

 
 
• Installation will begin and should take 5 -10 minutes to complete. 
• Click OK on ‘Installation Successful’ window to exit. 
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ck has been installed can be 
accomplished as done above for the main program (see pages 17-20, above). 

 in the ‘About AutoCAD Map 
3D 2009’ window. 

 pack’ is 

 After verifying the settings, click Close. 

 
• Optional Verification:  Verification that the service pa

• In summary, open AutoCAD Map 3D 2009; select About AutoCAD Map 3D from the 
‘Help’ menu dropdown; then, click Product Information

• On the ‘Product Information’ window, verify that the value for ‘Product service
‘AutoCAD Map 3D 2009 Version 2’ (or later, if newer service pack is installed). 

•
 

 
 

• Go to the ‘File’ menu dropdown and click Exit to close the program. 
 
• Other updates available at the time of this distribution can be found on the DVD in the 

Patches & HotFixes directory (i.e., <DVD DRIVE>:\Patches & Hotfixes\). 
• Note that the ‘Render Hotfix’ update contained on the DVD has been applied as part of 

Service Pack 1;   
ack / Update 1 per the 

& Hotfixes\Open Close Save 
Hotfix’ folder on the DVD. 

 
• Visit http://www.autodesk.com/support

• The ‘Open Close Save Hotfix’ can (should) be applied to Service P
‘OpenCloseSaveHotfixReadme.txt’ file in the ‘Patches 

 to check for the latest updates and service packs. 
 

 
• If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 

TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at 
(276) 523-0042 x13 or TBUCKMASTER@OSMRE.GOV. 
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